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Members’ Night Image Submissions – The image submission form on the club web site will 
be available from August 5th – 12th.  With the live edit format, images are due a few days early 
so that the reviewers can provide more detailed feedback.  Don’t forget! Images are due the 
Friday before the August 15th meeting, not the day of. 

ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not 
looked the way you expected?  The problem is probably a difference in how your computer 
and the club projector display colors and brightness.  You can fix this by calibrating your 
computer the same way our club calibrates our projector – with the ColorMunki.  Set up is 
simple and the calibration process only takes a few minutes.  Contact Lois Ritchie-Ritter at 
loisritchie@yahoo.com to reserve the ColorMunki. 

Photogram – If you have photo equipment that you are looking to sell, why not let club 
members know.  Send your submissions to carl.oday.rcc@gmail.com by the third Thursday of 
the month to be included in the following Photogram. 

Programs for August & September 2016 

 

Details for the current month’s programs may be found in the Programs article, starting page 3.

  

August 1st August 15th September 5th September 19th 

Competition 
Awards and Pot 

Luck 
 

Meeting Starts @ 6:00 

Members’ Night 
 
 
 
 
 

With Live Edit 
 

RCC 
Roundtable 

 
 

With Free Ice Cream! 

Mastering 
Macro 

 
 
 

With Frank Peele 

PHOTOGRAM 
Monthly Newsletter of the Redlands Camera Club 

August 2016 

Redlands Camera Club meets:  1st & 3rd Mondays, 7:00 pm 
First Presbyterian Church - 100 Cajon St - Redlands, CA 

Guests are always welcome 
 

© Redlands Camera Club & Contributors  The contents of the Photogram are copyrighted.  No material herein may be reproduced in any  
Manner without the written permission of either the Editor or the material’s specific contributor. 
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Carl Detrow 
 
      

 
 

Contrast 

 

July was an interesting month down at the old Camera Club. This is the first time in as long as I can 
remember that we didn’t have a meeting on a first or third Monday. Our forecast attendance numbers 
just didn’t support a meeting, so I hope you all had as good a time celebrating our nation’s 
independence as did I.   

Our second meeting was our Summer competition, which pushed the awards potluck back to the first 
meeting in August (August 1 at 6PM). I heard several comments that this was the best crop of entries 
yet. There were 115 images to look at, so we scheduled a break to give our judges (and my rear) a 
little rest. We’d be interested in what you thought of the competition. All I can say to all who entered, 
our competition committee, and our judges is, “Keep up the great work.” 

I was recently watching one of Kelby’s videos on Lightroom and learned something new. From my 
first Photoshop class in about 2004 (We used Photoshop CS) I was cautioned not to use the contrast 
slider, mainly because it was not very effective. Later, as I transitioned to Lightroom and PS Camera 
Raw, I was similarly warned. Kelby now says that Adobe has fixed the math behind the problems and 
the slider is now a very effective way to deal with contrast. That’s fine with me, because I always 
seem to make things worse when I try to use tone curves. I’ve tried the contrast slider after basic 
exposure adjustment and before further adjusting highlights and shadows (if required), and I’ve been 
surprisingly pleased by the results. 

Contrast is something that can often make an image better. We like to say it gives it “punch,” rescues 
it from flat lighting. Contrast is also something that makes our club great. It’s clear from the 
competition entries this time that we comprise a very diverse group of widely talented artists. The rest 
of society can go on and on about diversity of race, religion, or gender (English majors, let us cringe 
together.), but our club is made up of people of a variety of skill levels who like to photograph a lot of 
different subjects in a huge variety of ways. That is to our credit and to our advantage. We all share a 
common interest in the art of photography, and we all want to get better at it. And the best way to do 
that is to communicate with our fellow members.  

Those of us who are less skilled have no trouble taking classes or attending mentoring sessions, but 
feel intimidated just talking one-on-one with a best-of-show winner. I know, because I was myself in 
that kind of awe when I first joined. But now that I’ve gotten to know a lot of the very best 
photographers in our club, I find that most of them love to talk about their art, and are in fact flattered 
by the most basic questions. My advice: arrive at the meeting at least 20 minutes early and talk, 
preferably to someone you haven’t talked to before. Ask that golden question, “What do you shoot,” 
and learn from the answer. I guarantee our diversity will make you better. 

Happy shooting! 
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Jim Hendon 

 

 
 

 
August 1

st
 – Competition Awards and Pot Luck 

 Meeting starts at 6:00 pm – Bring Your Favorite Dish 
 

August 15
th

 – Members’ Night 
Get some first-rate feedback for your photos -- with on-screen coaching -- at our 
mid-summer Members Night on August 15. These valuable programs help us 
become better photographers through thoughtful, pointed reviews of our images 
and those of fellow RCC members. Our new format provides our images to 
handpicked reviewers and a Live Editor a couple of days in advance, giving them 
ample time to prepare comments and editing tips. Scheduled reviewers are Carl 
O’Day, Debra Dorothy and Dave Ficke, teamed with Bruce Woodcock as Live 
Editor. Submit one image via the RCC web site between Aug. 5 and noon, Aug. 
12. See you on the 15th! 

 
 
September 5

th
 – Annual RCC Forum with Free Ice Cream  

Come for the ice cream, stay for the fellowship and discussion! Young, 
old, beginner, expert -- we need RCC members of all kinds on Sept. 5 
to tell RCC leaders what we’re doing right, wrong and in between. We’ll 
start with a summary Year In Review presentation, then kick off the 
forum by inviting ideas, complaints, suggestions, whatever! We’ll also 
provide 3X5 cards to help capture all the good feedback. Scheduled to 
join us, listen and respond will be a host of key RCC leaders: Carl 
Detrow (president); Jim Hendon (VP, programs); Frank Peele, Bruce 
Woodcock (education); Debra Dorothy (field trips); Rick Strobaugh 

(mentoring); Russ Trozera (competitions); and Carl O’Day (RCC BLOG). Let’s make this the most 
productive forum ever. See you on Labor Day!      
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John Williams

 

 

Now is the time to renew your Membership for FY 2016-2017! 
 

Membership Renewal – Thanks to all of you who have renewed your RCC membership.  If you 
haven’t renewed, your Membership is now PAST DUE.  $25 is a great deal for all of the benefits that 
Redlands Camera Club offers.  The club's workshops, education classes, competitions, and field trips 
are only available to members in good standing.  Contact John Williams at jhwr@earthlink.net if you 
have any questions about your membership renewal. 

Prospective new members please note:  At Redlands Camera Club you’ll find a group of photo-
enthusiasts with a wide range of interests, a ton of experience and a willingness to share.  Our 
regular club meetings offer stimulating programs, members’ nights and competitions; in addition, we 
offer field trips, workshops, classes and opportunities for mentoring.  You can obtain an application 
form at one of our regular meetings or from our website by going to the club web site 
(www.redlandscameraclub.com), clicking on the “Downloads” tab and then clicking on “Membership 
Application” tab.  Follow the instructions on the form and your all set!  Dues are the primary sources 
of club revenue allowing us to provide you with quality programs and training.  Only currently paid 
members can take part in RCC classes, events, free workshops, field trips and competitions. 

Please introduce yourself to our new members and help direct them to members who can assist them 
become a better photographer.  We try to get a brief Bio from each of our new members.  Contact me 
by email (jhwr@earthlink.net) if your Bio has not appeared and you wish to have it included in the 
Photogram. 

A big welcome goes to the following newest members: 

John Donoghue 

Brandon Johnson 

  
Rick Strobaugh

 

 
 

 

I recently watched a show on Landscape Photography on Kelbyone.com. One of the discussions was 
on the Seven Deadly Sins of Landscape Photography. They were: 1 - Choppy water - smooth, 
reflective water in lakes and ponds usually looks best, 2 - Frozen water drops - waterfalls and 
streams usually look best as lacy blur of water. Shoot with slower shutter speeds. 3 - Crooked 
Horizon, 4 - Cloudless/uninteresting sky, 5 - No interesting foreground, 6 - Harsh mid-day sun, 7 - 
Distractions sneaking into the edges of your photos. Keep these deadly sins in mind when you are 
composing your photo scenes. Many of the most powerful images are the simplest images. Quite 
often, less is more for a powerful image. 

mailto:jhwr@earthlink.net
http://www.redlandscameraclub.com/
mailto:jhwr@earthlink.net
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Debra Dorothy  

             
 

San Diego Sites 

 
Date: August 24th Wednesday 

Location:  San Diego California 

Due to the distance, plan on this being a full day trip. 
Depending on Mother Nature I am hoping to get some 
good sunset opportunities. 

 

This is for all of you who have said you haven't shown up for any of the field trips because they are 
always on the weekends. This is your chance to partake in a camera club opportunity and have fun 
shooting with your fellow members. 

Here are a few possible locations we may be going to. 

Chicano Park Logan Heights San Diego 

Del Mar 4th Street Beach 

Star of India/San Diego Maritime Museum 

North Torrey Pines Bridge 

Since a lot of these places have limited parking its a good idea to plan on carpooling. We will meet at 
the Coco's Bakery Restaurant 1140 W Colton Ave, Redlands, CA 92374 at 9:00AM. 

Equipment List: 

Since we will be doing low light shooting a tripod is essential. 

A remote shutter release is a good idea if you have it. If not you can use the 10 second delay on your 
camera. 

Be sure you have full batteries and extras if possible 

Wide Angle Lens if possible 

Flashlight or headlight 

We will be walking a lot so comfortable shoes are a must. 

If you have any questions you can call me at 909 633-2913 or email me at 
Debbiedsd.dorothy@gmail.com 

mailto:Debbiedsd.dorothy@gmail.com
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Frank Peele  
 

RCC School of Photography Courses and Workshops 

 

August workshop: Editing Your Night Sky and Light Painting Images 
This workshop will be held on Monday, August 29, from 6:00 to9:00 p.m. in our normal club meeting 
room, John Knox Hall of the First Presbyterian Church. Although aimed specifically at RCC members 
who attended the Borrego Springs Night Sky Workshop and Field Trip, the information will benefit 
those who have taken images of the night sky and/or used light painting techniques. This will be a 
hands-on experience; Frank Peele will demonstrate using Lightroom and Photoshop (will apply also 
to Photoshop Elements users), then assist attendees in working with their own images.  
Bring to the workshop: laptop computer with your image editing software of choice, a multi-outlet 
extension cord, and one or two night sky, light painting (or combination) images for practice. The 
workshop is free to RCC members. 
 
New Session of RCC School of Photography Classes Starts in the Fall 
 
The 2016-2017 session of the Redlands Camera Club School of Photography begins Tuesday, 
September 13 with Exploring Digital Photography. This eight-week course is designed not only for 
those who are relatively new to using a digital camera, whether they have previous experience 
shooting film or not, but as well for those of any experience level who want a better understanding of 
how to use their cameras. Choosing the best camera and lenses, considerations of focus and 
exposure, understanding light, the principles of composition, an introduction to managing and editing 
your images in the computer – and much more – will be covered. There will be a strong hands-on 
emphasis, giving students the opportunity to put into practice the principles being taught. 
Tuition is $90. Class sessions are held from 6:00 to 9:00 p.m. Additional meetings of this class will be 
on the following Tuesday evenings: Sep. 20 and 27, Oct. 4, 11, 18 and 25, and Nov. 1. 
  
Instructor for this class is Frank Peele. Prerequisite for all classes is membership in the Redlands 
Camera Club. Dues are $25 per year, and membership allows taking multiple courses. In addition, 
free programs, classes and workshops are offered to members throughout the year.  
 
Exciting news is coming from Bruce Woodcock, who will teach a Digital Workflow class 
beginning on Nov. 8.  
 
If you have specific questions about these classes or the Redlands Camera Club’s educational 
offerings, call (909) 798-7999 or email educationworkshopsrcc@gmail.com  

 

mailto:educationworkshopsrcc@gmail.com
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Russ Trozera 
 

 

2016 Summer Competition 

 

The Redlands Camera Club would like to congratulate Debra Dorothy for winning Best of Show in our 
2016 Summer Competition.  The title of the image was Tussle scored 88.4.  The images will be on 
the web site on Monday evening.  The majority of the images in the competition scored 80 and above.  
That is really nice.  We are looking forward to the next competition is on December 5, 2016 where 
you can enter up to 3 images.  Image upload begins on Nov. 7 thru Nov. 21, 2016.  We would also 
like to congratulate all those that participated and also won ribbons.  It was a very good competition.   

Thanks to everyone 

 

If you have any questions, please email Russ at: photosbyruss@verizon.net 

  
Carl O’Day 
 

 

 

46 users and 312 images later the RCC Photo Blog is 

still going strong.  If you do not already have an account, 

send an e-mail to signup@rccphotoblog.com and we will 

get you set up.   

The blog is a great place to get input on your images – 

particularly with a competition coming up.  Other 

Members’ images can help you find some inspiration 

(and perhaps some motivation). 

Sign up today!  

mailto:photosbyruss@verizon.net
mailto:signup@rccphotoblog.com
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Wayne (Woody) Wood 

 
 

Robert Upton 

For as long as I can remember automobiles have been an 
all important part of my life.  Photography and the love of 
automobiles came together in the mid 50’s and began with 
a Kodak Brownie camera. 

My actual photography education was with the U.S. Army 
Signal Corps where I learned the “basics of photography” 
in 400 hours over a period of ten weeks.  The cameras 
used there were Graphic 4x5 press and 70mm combat 
cameras. No light meters. You had to learn to read the 
light. 

Throughout the 60’s, 70’s, 80’s, and 90’s I used a variety of 
35mm  cameras and specialized in sports car racing at 

various locations throughout the country. 

With the advent of the digital age, photography has become much more fun and a lot more rewarding 
for me.  For the past eight years, landscapeshad been my main interest and photographing 
landscapes with Jerry and Bessie Reece has been fun and a wonderful learning experience.  

I photograph with Nikon cameras (D800 & D500) mostly on tripod and process my images using 
Photoshop, Nik, Topaz and OnOne software. 
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2016 Summer Competition – Best of Show 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tussle 
Debra Dorothy 
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Club Calendar   

             Information that was available to the editor at the time of publication.  
 

August 1 Competition awards and pot-luck 

August 15 Members’ Night with live edit 

September 5 RCC Round Table Discussion – ask questions and provide your 
input into club activities 

September 19 Mastering Macro with Frank Peele 
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(Note:  The views expressed in this article are those of the author and do not  

necessarily reflect the views of the Photogram or of Redlands Camera Club.) 

 
Refining Selections using Adobe Photoshop CC 2015.5 new Select and Mask workspace 

By John Williams 
 

 Considerations when making a selection: 
Backgrounds should be contrasty to get clean cutouts.  For example, black hair should not be on 
a black background when cutting out people.  Therefore, when taking your photo, consider the 
background and make sure there is sufficient contrast between the subject and background.  If 
you are photographing people, place a light gray background behind the subject or a white 
background if you move your subject away from the background.  Do not use a green or blue 
screen behind your subject since there will be color contamination.  Light your subject using a 
small Softbox (26"x26" positioned 45° from your subject) if you are not doing a full body 
composite.  Then place a Stripbank rim light (14"x35") 180° opposite the Softbox giving a harder 
side light to your subject.  When you place your subject between the two lights, it may be 
necessary to feather the Softbox light by rotating the light towards the camera position so you 
get a softer light. 
Before making a selection make sure you reduces noise to get a more precise selection.  Also 
you should duplicate the image so have a good reference below the selection image.  When you 
make a selection don't forget to use the Edit in Quick Mask Mode (Q) to refine your selection.  
Also consider using one of the RGB Channels using the procedures described above.  Select 
and Mask workspace can be used to correct hairy, furry, fuzzy, and blurry areas of your 
selection. 
If you make a selection first before opening Select and Mask workspace, do not make a 
selection over transitional areas such a flyaway hair.  It's important to stay away from the edges 
with your selection on tricky areas when background show through items such as hair. 
Technique tip to increase contrast when combining two different images (composition):  
Open the image into Photoshop that you will be making a selection.  The ACR dialog box should 
open and then increase the exposure so that you have as much contrast between the selection 
area and the background as possible.  Then depress the Shift key and depress the Open Image 
button.  This will load the image into Photoshop as a Smart Object allowing you to return later 
and reduce the exposure and make other adjustments.  Next make a selection of the object and 
click on Select and Mask in the Options bar.  Output your selection as a Layer Mask.  You 
should have one Layer containing a thumbnail of the original image and a Mask.  Next drop this 
file into your background file.  Because the selection layer is a Smart Object, you can easily 
return to ACR and reduce the exposure and make further adjustments to blend the selection with 
the background. 
You need to accept that not every hair strand can be selected.  However, you will get acceptable 
selection detail when using the Select and Mask feature. 

 Select and Mask: 
The Select and Mask workspace replaces the Refine Edge dialog in earlier versions of 
Photoshop, offering the same functionality in a streamlined way. 
Several bugs have been reported to Adobe.  This new feature only works on a pixel layer 
(duplicate your Background Layer to get a pixel layer).  A workaround is available by double 
clicking a layer mask to enter the Select and Mask space on a non-pixel layer.  Adobe reports 
they are working on several fixes and request if you have a problem to send them your file. 
This workspace works best if you have a high resolution photo. 
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 To invoke the workspace, click Select and Mask in the Options bar when a selection tool is 
enabled.  Alternatively, you can press Ctrl+Alt+R or choose Select>Select and Mask.  You 
can also click on Select and Mask in the Properties panel for a Layer Mask. 

 

 You can set the default tool behavior, such that double-clicking a layer mask opens the Select 
and Mask workspace.  Simply double-click a layer mask for the first time and set the behavior.  
Alternatively, select Preferences>Tools>Double Click Layer Mask Launches Select and 
Mask Workspace. 

 Tools (left panel): 

o Quick Selection Tool:  Make quick selections based on 
color and texture similarity when you click or click-drag the 
area you want to select. The mark you make doesn’t need 
to be precise, because the Quick Selection tool 
automatically and intuitively creates a border. 

o Refine Edge Brush Tool:  Precisely adjust the border 
area in which edge refinement occurs.  For example, 
brush over soft areas such as hair or fur to add fine details 
to the selection.  To change the brush size, press the 
bracket keys.  Generally you only need to click on the Refine Edge Brush Tool to paint 
over edges of your selection in order to fine-tune your selection.  Magnify closer to the 
selection and paint over the areas that needs to be better defined.  If you depress the Alt 
key and click over an area, it will sample the color under the cursor and remove that color 
from the selection. 

o Brush Tool:  Begin with making a rough selection using the Quick Selection tool (or 
another selection tool) and then refine it using the Refine 
Edge Brush tool. Now, use the Brush tool to finalize or 
clean up details.  
Use the Brush tool to fine-tune selections in two simple 
ways: paint over the area you want to select in the Add 
mode (brush default), or paint over areas you don’t want 
to select in the Subtract mode (hold down the Alt key).  If 
you click on the minus icon on the options bar, you must 
depress and hold down the Shift key to return to the plus 
or add mode. 
With the Brush tool selected and over the on-screen 
preview, you can right-click and the popup dialog will 
allow you to change the Brush size, hardness, and 
spacing. 

o Lasso Tool:  Draw freehand selection borders. Using 
this tool, you can make precise selections. 

o Hand Tool:  Navigate around the photo. This photo works just like the Hand tool in 
classic Photoshop 

o Zoom Tool:  Magnify and navigate around the photo; works just like the Zoom tool in 
classic Photoshop.  You can also hold down the Z key to bring up the Zoom Tool and 
continue to click to zoom in.  To zoom out hold down the Z+Alt keys.  To return to full 
screen, depress the Ctrl+0 keys. 

 Options bar:   
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o Add or Subtract: Add or subtract from the refinement area. Adjust the brush size if 
necessary. 

o Sample All Layers: Creates a selection based on all layers instead of just the currently 
selected layer 

 Refine the selection:  You can refine your selection in the Properties panel of the Select 
and Mask workspace.  Adjust the following settings: 

o View Mode settings:  From the View pop-up menu, choose one of the following view 
modes for your selection: 

 Onion Skin (O):  Visualizes the selection as an animation-style onion skin scheme.  
This view is generally the best of all the views but it is important to lower the 
Transparency to 20-30%.  If the transparency is 100%, the background will be pure 
white; however, lowering the transparency shows you where to paint over along the 
edges. 

 Marching Ants (M):  Visualizes the selection borders as marching ants.  Marching Ants 
view mode is not generally useful in seeing your selection. 

 Overlay (V):  Visualizes the selection as a transparent color overlay.  Unselected 
areas are displayed in that color. The default color is red. 

 On Black (A):  Places the selection over a black 
background 

 On White (T): Places the selection over a white 
background 

 Black & White (K):  Visualizes the selection as a 
black and white mask.  To see any detail that might 
have been missed, switch the View to Black and 
White.  The selected areas will be white and if you 
see some gray areas that you don't want selected 
then paint them out or raise the Contrast to clean up 
the edges. 

 On Layers (Y):  Surrounds the selection with areas of 
transparency 
Note:  Press F key to cycle through the modes and X 
key to temporarily disable all modes. 

o Show Edge:  Shows the area of refinement. 

o Show Original:  Shows the original selection. 

o Transparency/Opacity:  Sets transparency/opacity for 
the View Mode. This setting applies beyond the Select 
and Mask workspace to the Overlay view mode in classic 
Photoshop. 

o Edge Detection settings:  You can see the radius in the 
document window by checking Show Radius box and 
then increasing the Radius slider.  However, if some 
areas are outside the Smart Radius area, increase the 
Radius and then paint over the selection area.  Usually a 
value of 5 to 15 pixels works well; however, each photo is 
different and you will need to experiment with the Radius 
pixel amount.  This allows you to selectively expand your 
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edge detection area, bringing in more details from the subject as Photoshop learns what 
is and isn't background.  Think of the Radius slider as paining around the entire selection 
at once.  If you increase the size of the Radius too much, unwanted background areas 
may start blending into the selection, and you can even lose areas that you initially 
selected and wanted to keep. 

 Radius.  Determines the size of the selection border in which edge refinement occurs. 
Use a small radius for sharp edges, and a large one for softer edges. 

 Smart Radius. Allows for a variable width refinement area around the edge of your 
selection. Among other use cases, this option is helpful if your selection is a portrait 
that includes both hair and shoulders. In such portraits, the hair might require a larger 
refinement area than the shoulders, where the edge is more consistent.  Once you've 
enabled Smart Radius, you'll usually want to re-adjust the Radius size with the main 
slider to see if you can get even better results.  Normally do not exceed a radius of 20-
pixels, otherwise you will get undesirable results. 

Important:  Try turning Smart Radius on and off to see if this option helps. 

o Global Refinement settings:  Generally you will not need to use these adjustments 
sliders with the exception of Shift Edge. 

 Smooth:  Reduces irregular areas (“hills and valleys”) in the selection border to create 
a smoother outline.  Normally Smooth Edge doesn't do much.  Be aware that using 
too high a Smooth value can “clip” small details along the edge of the selection. 

 Feather:  Blurs the transition between the selection and the surrounding pixels. 

 Contrast:  When increased, soft-edged transitions along the selection border become 
more abrupt. Typically, the Smart Radius option and refinement tools are more 
effective.  Usually you will not use any contrast adjustment.  It generally ruins the edge 
when overdone, so keep it below 10%.  However, if you want a sharp defined edge 
then increase the Contrast slider about half way and see what happens. 

 Shift Edge:  Moves soft-edged borders inward with negative values or outward with 
positive ones. Shifting these borders inward can help remove unwanted background 
colors from selection edges. 

o Output Settings  

 Decontaminate Colors:  Replaces color fringes with the color of fully selected pixels 
nearby. The strength of color replacement is proportionate to the softness of selection 
edges.  If you see a lot of fringing around hair, which is caused by remaining color 
from the original background, then use Decontaminate Colors option. 
Important: Because this option changes pixel color, it requires output to a New Layer 
or document.  Retain the original layer so you can revert to it if needed. 

 Output To:  Determines whether the refined selection becomes a selection or mask 
on the current layer, or produces a new layer or document.  Normally will want to 
output your cutout to a New Layer or New Layer with Mask. 

Reset:  Click  to reset the Workspace and revert the settings to the original state in which 
you entered the Select and Mask workspace.  This option also reverts to the original 
selections/masks applied to the image when you entered the Select and Mask workspace. 
Remember Settings:  Select Remember Settings to save the settings for use with future 
images. The settings are applied afresh to all future images, including the current image if it 
is reopened in the Select and Mask workspace. 

 Shortcut keys: 
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o Depress the 'P' key to see a before & after preview. 

o Depress the 'F' key to cycle through the view modes. 

 Recommended steps to refine your selection using Select and Mask workspace. 

1. Either start with a selection, or open the Select and Mask workspace.  Choose the 
Onionskin View mode and choose a selection tool from the Tool bar. 

2. If there are any areas of your image not selected that should be, use the Quick Selection 
tool to paint them in quickly. 

3. Select the Refine Edge Brush and start by clicking on the background area outside your 
selection to define the hue you want to mask out, then drag the brush into your 
edges/hair.  The more you refine the selection, the smarter it gets and the whole edge 
begins to look better. 

4. Slide your Transparency slider up to 100% so you can view the cut out on its own and 
view any additional areas that need fixing. 

5. Turn on Smart Radius in Edge Detection section. Select a radius of 5-px since this will 
help bring in some of the finer details. 

6. In the Output Settings, check the Decontaminate Colors box to remove any remaining 
hue around the edges of your selection. 

7. Use the Global Refinements sliders to fine tune your selection.  The one most likely 
slider to use is the Shift Edge to reduce the selection which will remove unwanted areas 
around the edges. 

8. Select the Black & White view and use the Brush tool to mask in or out (depress Alt 
key) any remaining sections especially near the edges of the cutout. 

9. When you’re happy with your selection, click on the Output dropdown menu and choose 
your output method.  In most cases for a non-destructive workflow, choose New Layer 
with Layer Mask. 

10. Check the Remember Settings box if you plan on doing multiple cutouts of the same 
type of image and press OK to confirm you are finished. 

 Recommended steps after you output your selection to a new Layer: 

 Before refining your mask, make a copy of your selection in order to revert to the 
original selection: 

o Ctrl-click on the mask to bring up the marching ants. 

o Select Channels and make a copy of your mask (click on 'Save selection as channel' 
icon at bottom of panel). 
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 Defringe halo/white around edges: 

o First method: 

 If there are extra pixels around a selection, creating a halo effect, defringe the 
selection. 

 Copy the selection onto a new layer.  If you already made a Mask, the Ctrl-click on 
the mask to bring up the selection on the image (marching ants) and then depress 
Ctrl+J.  This will place the selection onto a new layer with transparent areas around 
the selection. 
You can also right-click the mask and select 'Apply Layer Mask' which will apply the 
selection on a new layer with a transparent background. 

 Before attempting any fix, zoom in on the fringed edge to readily see the problem and 
how the solution is working.  Determine the width of 
the fringe in pixels. 

 Choose Layer>Matting>Defringe.  Then select 1 
pixel for the width or the number of pixels you 
determined by zooming in close to the edge.  If that 
doesn't work, then undo (Ctrl+Z) and try 2 or 3 pixel 
Defringe. 

 To see a before/after view, choose undo (Edit>Undo or Ctrl+Z) and then an redo the 
Defringe adjustment (Edit>Redo; or Ctrl+Z). 

 If the Defringe tool does not remove the pixels then choose Layer>Matting/Color 
Decontaminate.  This option changes the color of the stray pixels to match the color 
of a surrounding object. 

o Second method:  If your cutout has a primarily white of black background, try going to 
Layer>Matting>Remove White/Black Matte.  If the background was primarily white this 
will remove the white fringe around the cutout.  Sometimes you may see some faint black 
smudges around the cutout which can be removed by using the Eraser tool (background 
around cutout is transparent). 

o Third method: 

 Duplicate the Layer and Zoom Into the fringe area. 

 Apply a Gaussian Blur and increase the radius until the fringing color is gone.  Use the 
minimum amount of blur to remove the fringe color. 

 Set the Blending Mode of the Blurred Layer to Color. 

 Add a Black Mask and paint with white over the fringe areas. 
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o Fourth method: 

 Click the fx button at the 
bottom of the Layers panel 
and in the popup select 
Inner Shadow. 

 Click on the Set color of 
the shadow swath box 
(same line a Blend Mode 
indicated by red arrow) and 
with the Color Picker 
eyedropper select the dark 
hair color of the cutout. 

 Then move the Size slider 
to remove the white fringe.  

 Try duplicating (Ctrl+J)the cutout 
layer.  For hair it may build up and enhance some hair areas.  However, you may not get 
satisfactory results in other areas when duplicating.  Add a Layer Mask and paint out those 
areas. 

 Add a solid color layer:  It is best to see your work against a solid background color 
(teal/green/magenta color).  Click on Create New Fill or Adjustment Layer icon (half circle) 
and select Solid Color.  The Color Picker will pop up and select a background color.  Click 
on the new Color Fill layer and drag it below the Mask Layer. 

 
 

 
 
 

If anyone is interested in Kodak slide carousels please contact Carl Detrow at csdetrow@verizon.net. 
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